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This Read Me file provides information about enhancements to the software and corrections to 
the printed documentation. This file is set up in the following sections:  

* Differences between Finale 3.0.2 and Finale 3.0
* Corrections and clarifications
* Running both Finale 3.0 and Finale 2.2 
* Removing Finale 2.2 from your system
* Finale and the File Manager
* About the FINALE.INI
* About the FINMIDI.INI
* Troubleshooting

Differences between Finale 3.0.2 and Finale 3.0

Finale 3.0.2 contains some minor corrections and enhancements to Finale 3.0. 

-- The MIDI Setup dialog box is invoked automatically the first time Finale is run.
-- A new FINALE.INI key has been added to the [settings] section. See "NewWinMax" in the 
"About the FINALE.INI" section, below.
-- Two new FINALE.INI keys have been added to the [settings] section to correct the following 
problems: Slow printing (or no printout) to non-PostScript printers, and large PostScript files. See 
"IndependentPSPages" and "FontScaleMode,"  in the "About the FINALE.INI" section, below.
-- A new command named "German Spelling" in the Chord menu lets you switch to the German 
style of spelling chords. A root of "B" is spelled "H" and a root of "B flat" is spelled "B."
-- Finale is now sensitive to the date, time, and decimal settings in the International portion of the 
Control Panel. 
-- The date formats in the Document Options dialog box have been reduced from three to two, 
reflecting the short and long formats set in the International portion of the Control Panel.
-- The available pages sizes in the Compile PostScript dialog box now include A4 and B5 page 
sizes.
-- Default whole rests are now centered between barlines [the front and back separations in the 
Music Options dialog box are ignored].
-- Tuplets with slurs actually use slurs (with tapered ends), unless the slur is "broken" in which 
case it uses curves (with non-tapered ends).
-- The default setting for the tuplet visual definition (when the default file or a template is not used) 
has been changed from a number only to a number with a "broken" bracket, and the default 
positioning has been improved.
-- If a Staff or Score Expression Metatool has never been programmed, the Staff or Score 
Expression Selection dialog box now defaults to a text expression.
-- Inactive views of open music documents are now updated when edits are made to elements 
such as smart shapes, chords, score and staff expressions, articulations, clefs, repeats, measure 
numbers, ossia measures, titles, and text blocks.
-- Handles on tuplets are now removed when you change layers.
-- Finale no longer creates a duplicate title when you change a title's font. (This only happened in 
rare cases.)
-- Fixed the display of noteheads after applying music spacing to measures containing rhythmic 
notation and multiple layers.
-- Applying beat spacing with slash notation now spaces the measure correctly.
-- Playback of grace notes on the first beat of the first measure has been fixed (the grace note will 



play on the beat, however, not before).
-- The vertical and page scroll bars give correct feedback when viewing at sizes other than 100%.
-- Special Tools correctly displays handles for multiple layers.
-- Ties can now be entered on a grace note that is the last note of a measure. 
-- Placing mid-measure clefs on reduced staves in Page View has been improved.
-- Clef changes at the end of alternate notation sections now show properly.
-- The Respace button in the Staff Usage List dialog box now respaces the current staff set, not 
the master list (All Staves).
-- Fixed rounding problems in dialogs when using units like inches.
-- PostScript tie variables are now used when printing directly to a PostScript printer.
-- Finale now correctly prints fonts larger than 48-point when printing to a PostScript printer.
-- Articulations attached to rests now appear on printout.
-- Fixed a General Protection Fault in the There Are Too Many Beats In This Measure dialog box 
that occurred when using the control-menu box.
-- Fixed an error that occurred if Finale performed an "autosave" to a non-existent directory 
specified in the Program Options dialog box.
-- Finale updates the registration database each time Finale is launched to prevent a General 
Protection Fault in the File Manager. This updates the path if Finale has been moved or launched 
from a different place. 
-- Finale now uses the correct values in the Quantization dialog box after you set up Floating 
Quantization.
-- If the Finale Help file is not located in the same directory as Finale, Finale will parse the 
HELPFILES environment variable for its location. (We recommend that you keep the Finale Help 
file in the same directory as Finale.)
-- When you use the "i" command-line switch, Finale no longer tries to open the INI file as a music 
file.
-- A number of cosmetic changes have been made.

Corrections and clarifications

Petrucci Key Caps

The header over the keycaps is missing. The header indicates which key to press when typing 
the letter or ANSI number to display the corresponding Petrucci music character. Note, this 
header does appear correctly on your Quick Reference Card.

With With With With With
Key Alone Shift Key Alone Shift ALT+ ALT+ ALT+
---------------------------------------------------------------------------------------------------------------------
A Y 0126 0185 0220
etc.

To make this change, see Volume 3, p. 400.

Trill marking

The trill character ~ appears twice on the Petrucci Key Caps. It should appear only in the 0126 
position, not the 0127 position.

To make this change, see Volume 3, p. 400, and the Quick Reference Card, p. 6.



Measure and Page counters (Document window)

Use the Delete key, not the Backspace key in the measure and page counters.

Music spacing (Mass Edit menu)

The status of the Clear Manual Positioning checkbox in the Music Options dialog box only affects 
Beat and Time Signature Spacing, not Note Spacing. If you apply Note Spacing, Finale will 
always remove any manual positioning you've done. If you want to maintain your manual 
positioning, use the Apply Beat Spacing command instead, and make sure that Clear Manual 
Positioning is unchecked in the Music Spacing Options dialog box.

To make this change, see Volume 3, Mass Edit menu and Music Spacing Options dialog box.

Rebar after changing Time Signature (Program Options dialog box)

You may want to pay close attention to this setting in the Program Options dialog box, reached 
through the Options menu. When this checkbox is selected, Finale will rebar the music 
(reorganize the music rhythmically) in all affected measures when changing Time Signatures. 
Rebarring the music automatically ensures that all affected notes fall into the correct measures. 
As it rebars, Finale may split notes into tied notes, split a note across barlines with a tie, rebeam 
your music, as well as cause certain other changes.

If you want to prevent Finale from making these changes when changing Time Signatures, 
deselect this checkbox. 

To make this change, see Volume 3, Program Options dialog box.

Handles on staves in Page View (Staff Tool)

Finale 3.0 automatically displays one or two handles on each staff in Page View when the Staff 
Tool is selected. Drag the top handle to adjust the global position: Finale adjusts the spacing for 
every staff system in the piece. If Special Part Extraction is off (unchecked in the Edit menu), 
Finale adjusts the position of the staff in Scroll View as well. If Special Part Extraction is on 
(checked in the Edit menu), Finale only adjusts the position of the staff in Page View. leaving the 
positioning of the staves in the full score untouched.

If you've optimized a staff system, two handles appear on each staff in the optimized staff system. 
Drag the bottom handle to adjust the position of the staff in the current staff system only. 

To make this change, see Volume 1, p. 134; Volume 2, Optimizing systems, Page Layout, and 
Systems; Volume 3, Staff Tool, Optimizing a System of Staves dialog box and Page Layout menu.

Positioning arrows for chords and lyrics

For an explanation of how the four positioning arrows work for chords and lyrics, see Volume 3, 
Chord menu -- "Position Chords * Position Fretboards," p. 63; and Click Assignment window 
--"[Four positioning arrows]," p. 71, respectively.



Running both Finale 3.0 and Finale 2.2

You may want to keep Finale 2.2 on your hard drive until you're sure that Finale 3.0 is properly 
installed and functions smoothly on your computer. 

The first time Finale runs

When 3.0 launches for the first time, it sets up certain defaults and adds the necessary music 
fonts to your system. It will also determine if you've previously run an earlier version of Finale on 
your system. If so, it will ask you: 

* If you wish to remove older versions' information stored in the WIN.INI file

* If you wish to remove the older bitmap fonts from your system software

Click "Yes" to both questions for the following reasons:

It is not strictly necessary to remove, or "clean up," information in the WIN.INI file, but doing so 
will slightly reduce the size of your WIN.INI. Because the WIN.INI has a maximum size limit, it is 
good practice to remove unused information when convenient. However, if you plan to use Finale 
2.2 or earlier versions as well as 3.0 in the future, you may leave this information intact. For more 
information, see "Running Finale 3.0 and 2.2 on the same system," below.

However, we strongly recommend that you remove older bitmap fonts. Since Finale 3.0 uses 
newer font technology than older versions of Finale, it will not display music characters correctly 
unless the older bitmap fonts are removed. This process does not delete bitmap fonts from your 
hard drive, but does remove them from the Windows system; they can be reinstalled into the 
Windows system at any time.

Converting older documents into Finale 3.0 documents

Finale 3.0 has a different file format than earlier versions, and converts older files to the new 
format when you open them. You should be aware of two points:

* Finale 3.0 will open and convert older versions' files, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted file with a different name than the 
original file, keeping the older unconverted file as a backup.

* Finale 2.2 (and earlier versions) cannot open any Finale 3.0 file, except Standard MIDI 
Files.

Running Finale 3.0 with Adobe Type Manager

When you installed Finale 3.0, the Petrucci and Seville fonts were automatically installed into the 
Adobe Type Manager Control Panel. Finale 3.0 does not require ATM, but using ATM will often 
improve the on-screen display of many non-TrueType text fonts. However, if you use mainly 
TrueType fonts, using ATM will be of little benefit.

Running Finale 3.0 and 2.2 on the same system

Finale 3.0 is designed to cooperate with earlier versions of Finale as much as possible, even 



though the new version uses different font technology. It is possible to use version 3.0 one day 
and run an older version such as 2.2 the next, if you wish. However, it is possible that by 
alternating between different versions, music characters might not be displayed correctly on-
screen. If you wish to alternate between using more than one version, here are some issues to 
keep in mind:

* Do not run more than one copy, or "instance," of Finale simultaneously, even if the 
versions are different. Finale 3.0 is designed to run only one instance at a time. As in the past, it 
is possible to run more than one instance of Finale's older versions, but you should avoid these 
situations because they may make Finale unstable. If an older version of Finale (such as 2.2) is 
already running, attempting to launch 3.0 will launch a second instance of the older version. If 
Finale 3.0 is already running, the second instance will not run. This protects you from system 
instability.

* Finale 3.0 uses slightly different music fonts and newer font technology than older 
versions. If for some reason you replaced the newer music fonts with old fonts, re-install the 
newer fonts using your Finale 3.0 installation disks. Several minor enhancements, such as slight 
adjustments to the widths of certain characters, exist in the new PostScript and TrueType fonts.

* Finale 3.0 and 2.2 automatically install the screen fonts for each version, when they are 
launched. The information is loaded from the hard drive.

* If you wish to use Finale 3.0 after running an earlier version, remove the older bitmap 
fonts so 3.0 will display music properly. Launching Finale 3.0 automatically offers you this option 
when necessary; you do not need to enter the Windows Control Panel. If you decide not to 
remove them, music characters in Petrucci and Seville may appear incorrectly positioned. 
Remember that removing the fonts from the system will not delete them from the hard drive.

* If you wish to continue using earlier versions of Finale as well as 3.0, you should 
experience few problems. Whether or not you use ATM, you may experience better performance 
on-screen if you temporarily remove Petrucci TrueType (Regular) from the Fonts program in the 
Windows Control Panel; see your Windows system documentation for more specific instructions. 
Do not delete it from the hard drive. If you only remove it from the Windows system, leaving it on 
the hard drive, Finale 3.0 will re-install the font automatically the next time you run it.

* After you have run Finale 3.0, launching an earlier version of Finale may display the 
Printer and MIDI Setup dialogs. This is normal behavior. If you elected to remove older Finale 
settings from the WIN.INI file the first time you launched 3.0, you'll need to reset printer and MIDI 
settings. If you didn't remove the older settings, they will be unchanged; if you click OK to both 
dialogs you can continue to work normally in the older version of Finale.

Removing Finale 2.2 from your system

After you've ensured that Finale 3.0 runs properly on your computer, you should remove Finale 
2.2 and all of its supporting files. You may want to check the following items to make sure that all 
the supporting files (old fonts and DLLs) for Finale 2.2 are removed. 

These instructions assume that you have installed Finale 3.0 to a different directory than Finale 
2.2. (By default, the installer creates a FINALE3 directory to store your new Finale 3.0 application 
and files. Earlier versions of Finale were installed by default into a directory named FINALE.)

Back up all of your old Finale 2.2 documents to floppy disk. Be sure to include all music 
files, custom templates, and custom libraries that you've created.



Removing old Finale 2.2 files

If you want to convert Finale 2.2 documents to new Finale 3.0 files, create a directory in your new 
FINALE3 directory named OLDFILES. Copy all of your old Finale 2.2 document files there. Be 
sure to include all the music files, custom templates and libraries that you want to use or 
complete in Finale 3.0.

The following is a complete list of the files shipped with Finale 2.2. If you no longer intend to use 
Finale 2.2, these files can be deleted. Be sure to back up any document and font files that 
you want to continue to use.

File(s) File name(s) Location 
Finale Program Files FINALE.EXE C:\FINALE

FINDLG.DLL
MIDI drivers MPUDRVR.DLL C:\FINALE

IMFDRVR.DLL
C1DRVR.DLL
MIDIDRVR.DLL

Finale Default File DEFAULT.MUS C:\FINALE 
Tutorial Batch File TUTBAT C:\FINALE\TUTFILES 
Libraries C:\FINALE\LIBRS 
Templates C:\FINALE\TEMPLS 
System Fonts PETRUB.FON C:\WINDOWS

PETRUC.FON
PETRUD.FON
PETRUE.FON
SEVILB.FON
SEVILE.FON 

PostScript Fonts PETRU.PFM C:\PSFONTS
PETRU.PFB
SEVIL.PFM
SEVIL.PFB 

LaserJet Fonts PETHP_24.SFP C:\PCLFONTS
PETHP_24.SFP
PETHP_21.SFP
PETHP_21.SFL
PETHP_18.SFP
PETHP_18.SFL
PETHP_16.SFP
PETHP_16.SFL
PETHP_12.SFP
PETHP_12.SFL
SEVHP_36.SFP
SEVHP_36.SFL
SEVHP_18.SFP
SEVHP_18.SFL

Removing the Finale section from WIN.INI

Finale 2.2 stored its configuration information in WIN.INI. Finale 3.0 stores its configuration 
information in a file called FINALE.INI (see "FINALE.INI" below). 

The first time you run Finale 3.0, it will offer to remove the old Finale 2.2 settings from WIN.INI. 



This is recommended because it reduces the size of WIN.INI somewhat. If you choose not to let 
Finale 3.0 remove the settings for you, you can remove them manually.

Open the WIN.INI file with a text editor such as Windows Notepad. Scroll through the listing until 
you see the Finale section. It should look something like this:

[Finale]
Port0=
Port1=
Port2=
Port3=
init=
MIDI SendSync=
SendPetrucci=
OwnPS=
MIDISync=
MIDRcv=
MIDEcho=
MusicFont=
MIDIRoot=
MIDIDevs=

This entire section can be deleted.

In addition, any section with the following names can be deleted as well:

[MIDIDRVR] [MIDIDRVR.EXE] [MIDIDRVR.DLL]
[MPUDRVR] [MPUDRVR.EXE] [MPUDRVR.DLL]
[C1DRVR] [C1DRVR.EXE] [C1DRVR.DLL]
[MMEDRVR] [MMEDRVR.EXE] [MMEDRVR.DLL]
[IMFDRVR] [IMFDRVR.EXE] [IMFDRVR.DLL]
[SBLDRVR] [SBLDRVR.EXE] [SBLDRVR.DLL]

Removing old Finale screen fonts

Run the Windows Control Panel and launch the Fonts program. Select the following fonts and 
delete them:

Petrucci 24,18,14,12 (Set #3)
Petrucci 24,18,14,12 (Set #4)
Petrucci 24,18,14,12 (Set #5)
Petrucci 24,18,14,12 (Set #6)
Seville 36 (Set #3)
Seville 36 (Set #6)

Finale and the File Manager

Finale 3.0 conforms more closely with standard usage of the File Manager. In particular "drag and 
drop" and command-line switches are now supported.

Drag and drop



Drag and drop is supported for opening files. Start Finale and File Manager. In File Manager, 
select the Finale files you wish to open. Drag them to Finale's window and release the mouse 
button. The selected files will be opened in Finale. Finale also supports printing from the File 
Manager: see your Windows documentation for details.

Project icons

You can create Finale icons in Program Manager for different projects. This feature can be used 
to specify groups of files such as a score, and all extracted parts of a score. Use icons in 
conjunction with the command-line switches below, specifying different sets of files and perhaps 
an alternate FINALE.INI file, to customize your Finale working environment.

Command line

Finale supports multiple filespecs and wildcards in the command line of a Program Manager icon. 
For example, specifying *.mus on the command line will open all the music files in the current 
directory. Finale also supports the following command-line switches. These switches can appear 
in any order, anywhere in the command line. They are not case sensitive, and can be combined. 
Either '-' or '/' acts as a switch trigger.

-q Instead of launching Finale and displaying an "Untitled" document, it displays the 
Open dialog box and prompts for the file you want to open. The Open dialog box appears once 
for each "q" switch in the command line.

-n Launches Finale without loading the MIDI drivers. This can be useful if you are 
running other MIDI software, or if there is some other MIDI related problem on your system.

-x Launches Finale without opening any documents, not even a default "Untitled" 
document.

-i Lets you specify an alternate FINALE.INI file. Enter the file name of the INI file 
you want Finale to draw its settings from. This can be very useful if you share your computer with 
someone else, or if you have different projects that require different global settings.

-p Prints the first file on the command line.

Examples:
Finale -qn Start Finale without MIDI and prompt for a file name.
Finale pr1\*.mus -i finale.pr1 Open all the files in the PR1 directory, and use the 

settings in FINALE.PR1 instead of FINALE.INI.

About the FINALE.INI

The FINALE.INI file contains custom settings and Finale Preferences that you set within the 
Finale program. Finale Preferences include dialog boxes and menu settings that affect your 
Finale working environment. They do not include settings that differ from document to document. 
Most of the options in the FINALE.INI can and should be set within the Finale program itself. 
Other settings can only be changed in the FINALE.INI file. For example, you may need to change 
the font used for the Finale's Message Bar, depending on the fonts installed in your system. 

The FINALE.INI file can be edited with a text editor such as Notepad. In general, you will not 
need to edit this file directly. Do not edit the FINALE.INI file while Finale is running. 

If you choose to edit the FINALE.INI file, be sure to make a backup of it first! If you make an 
accidental change, you can either restore the backup copy of the FINALE.INI file, or delete the 



edited FINALE.INI file. When you launch Finale again, Finale will re-generate a new FINALE.INI. 
If Finale creates a new FINALE.INI file, any custom settings and Finale Preferences you had 
saved in your previous INI file will be lost.

The FINALE.INI file is divided into sections, which are separated by headers that appear in 
square brackets. The FINALE.INI consists of the following sections:

[Settings]
[MIDI]
[Extensions]
[Program Options]
[Palettes]
[Directories]
[PrevFiles]

Each section below contains a general description of the section as well as an explanation of the 
settings within the section. Each setting contains a more detailed explanation, and is marked 
either Set in Finale, Optional, or Do not edit. The default values are also listed for each setting. If 
a key is not found in the FINALE.INI, then the default value will be assumed. Settings that are 
marked "Do not edit" should ordinarily be left alone. Edit such settings only if you are having a 
particular problem and you know exactly what you are doing!

[Settings]

This section includes general settings that can enhance your Finale working environment.

Init=(0, 1)
Do not edit. The default is 0, which indicates that Finale has never been run on this 

system. Finale sets it to 1 the first time it launches, and allows you to personalize your copy of 
Finale by entering your name and serial number.

MusicFontName=Petrucci
MusicFontSize=24

Set in Finale. Reflects the default music font and size that you specify in the Data Check 
dialog box.

HandleSizeX=0
HandleSizeY=0

Optional. When set to 0, Finale displays handles on editable music elements using a 
default size. You may want to change these values (which are measured in pixels) if the handles 
are either too large or too small. For example, if you set your monitor to a high resolution, the 
handles that Finale displays may be too large in relation to the elements in your score. In this 
instance, the handles may completely obscure an element such as a staccato marking.

IncludeFonts=(0, 1)
Set in Finale. Use the Include Fonts in Listing checkbox in the Compile PostScript dialog 

box to control this setting.

MaxPSFontsPerPage=15
Do not edit. This setting controls the number of fonts that will fit into your printer's virtual 

memory. Although a higher number may result in faster printing, it may also increase the risk of 
PostScript errors.

PSXResolution=1000



PSYResolution=1000
Do not edit. These settings control the resolution of coordinates in PostScript files and 

printing.

MsgBarHeight=0
Optional. Defaults to 0. If set to 0, the height is automatically calculated from the 

MsgBarFontHeight and MsgBarBorder settings. Otherwise, it uses the height (in pixels) you 
specify.

MsgBarBorder=3
Optional. Defaults to 3 pixels. The border is contained within the MsgBarHeight. 

MsgBarFontHeight=0
Optional. Defaults to 0. If set to 0, the Message Bar font will be 10 pixels high. If you need 

to change the size of the message bar font, enter the value in pixels. For example, if you enter 
12, the font will be 12 pixels high, and the Message Bar height adjusts to the specified size. Hint: 
sizes between 8-12 work best.

MsgBarFont=
Optional. Defaults to no specific font, so that Finale displays a sans serif font provided by 

Windows. Enter the exact font name that you want Finale to use for the Message Bar display. 
Example: MsgBarFont=Arial

MsgBarTop=(0,1)
Optional. Defaults to 0, so the Message Bar appears at the bottom of Finale's main 

window. If you want the Message Bar to appear at the top of Finale's main window, change this to 
1.

MsgBarShow=1
Set in Finale. Choose Message Bar from the Windows menu. Defaults to 1 so that the 

Message Bar appears in Finale. If this is set to 0, Finale's Message Bar will not appear.

MaxFileAlert=10
Optional. Defaults to 10. This determines the maximum number of files that can be 

opened before a warning appears. You can open more than one file at a time, by using  the 
command line, or by using the drag and drop feature in the File Manager. When the warning 
appears, you can choose to continue to open the files, but you may run into memory limitations. 
This guards against accidentally trying to open hundreds of files.

LoadWinPos=0
SaveWinPos=0

Set these options in Finale. Use the Program Options dialog box to determine what will 
be saved. They refer to the following settings: Load Window States at Startup, Save Window 
States at Exit.

MaximizeWin=0
WinPos=(left) (top) (right) (bottom)

Do not edit. These settings are controlled by the LoadWinPos and SaveWinPos. 
MaximizeWin determines the state of the Window: 0 = normal, 1 = maximized, 2 = minimized. 
WinPos determines the position of the main window. If you want to alter the positioning of your 
windows, position the windows in Finale, and use the Program Options dialog box to Save or 
Load the window positioning.

SerifFont=
SansSerifFont=

Optional. Default serif font is "Arial," the default sans serif font is "Times New Roman." 



These fonts are used for any text elements that you can't set the default fonts for within Finale. 
The default fonts for the majority of text elements in Finale are controlled in the Select Default 
Fonts dialog box (Options menu). If the specified font is not available, Windows provides an 
alternative font.

FretboardFont=
FretboardSize=

Optional. Defaults to "Seville" 36 point. We do not recommend changing the font used for 
the fretboards.

OtherPoolSize=
DetailPoolSize=
EntryPoolSize=

Optional. Default  = 96. These settings control the size of Finale's internal data caches. 
Up to a certain point, a larger cache will give better performance. Beyond that point, however, 
performance degrades. This point will be different for different machines. You may want to 
experiment with different settings. Minimum value is 4; maximum value is 1500 for OtherPoolSize 
and DetailPoolSize, 300 for EntryPoolSize.

NewWinMax=
Optional. Defaults to 0. If 1, all new document windows will be opened maximized. 

IndependentPSPages=
Optional. Defaults to 1. The standard setting of 1 is compatible with print spoolers, but 

results in larger PostScript files. We recommend setting it to 0 to reduce the size of the PostScript 
file, and to reduce the number of times a font is downloaded. If  0, printer memory will not be 
reset after each page in compiled PostScript files. The resulting file will not be "Adobe 
conforming" meaning that it might confuse some spoolers, but will download more rapidly. (This 
setting is equivalent to the Advanced Option, "Clear Memory Per Page" in the Windows 
PostScript driver setup dialog box.) 

FontScaleMode= 
Optional. Defaults to 0. This setting determines how bitmap fonts are rendered when an 

exact match cannot be found. If 0, Finale will try to scale the bitmaps. If 1, Windows will scale the 
bitmaps. If set to 2, Windows will substitute the "closest" TrueType font. Setting this option to 1 or 
2 will avoid potentially long printing times to non-PostScript printers. 

[MIDI]

MIDIRoot=FINMIDI
Do not edit. This entry stores the name of Finale's own MIDI driver. It should never be 

changed.

MIDIEcho=0
MIDISendSync=0
MIDIEcho0=0 1 2 3 4 5 6 7 8 9
MIDIEcho10=10 11 12 13 14 15 16 17 18 19
MIDIEcho20=20 21 22 23 24 25 26 27 28 29

All of these settings are set within Finale by choosing MIDI Sync and MIDI Thru from the 
Options menu.

[Extensions]



This section contains optional settings that control the extensions Finale uses for its files. You 
should only make changes if you have a conflict with another application. Note that the 
extensions do not include a period. The Backup extension supports the standard DOS wildcards 
'*' and '?'. For example, "Backup=??_" will save backup files with the first two characters of the 
original extension followed by an underscore. If you choose to set a backup directory (see 
"BackupDir" below), you may want to have backup files retain their original extensions. In this 
case you would use "Backup=*".

Music=MUS
ETF=ETF
MIDI=MID
Playback=PLY
Transcription=NOT
Postscript=PS
Library=LIB
Clip=CLP
Backup=BAK
EPS=EPS
Track=TRK
AutoSave=ASV
Template=FTM

[Program Options]

This section contains performance settings that are controlled in, or related to the Program 
Options dialog box.

Purge=0
Optional. Defaults to 0. Finale does not clean out Temp files when you close files. 

Although this helps Finale to run faster, if you open or close a lot of files, you could potentially run 
out of disk space. If you have limited disk space you may want to set this to 1 so that Finale 
cleans out the Temp files when you close a file. You will notice that Finale takes longer to close 
files.

DottedRests=0
Optional. Defaults to 0, which means that dotted rests are not allowed during 

transcription. If you set it to 1, dotted rests are allowed during transcription.

DefaultFile=DEFAULT.FTM
Optional. Default is DEFAULT.FTM. If you want Finale to use a different file, you can 

either change its name to DEFAULT.FTM, or enter its name here.

g0=0 0 0 0 0 0 0 0 0 0
g10=0 0 0 0 0 0 0 0 0 0

Do not edit. These settings are controlled by the Program Options dialog box.

[Palettes]

This section contains positioning and tool arrangement for the palettes in Finale. Most of these 
settings are saved when Save Window States at Exit is selected in the Program Options dialog 
box.



AutoClosePalettes=1
Set in Finale. Defaults to 0 so the palettes remain on the screen when you select another 

tool on the Main Tool Palette. When set to 1, closes the sub palettes when leaving the tool.

MainPalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)
SimplePalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)
SmartPalette=(on) (current tool idx) (anchor) (left) (top) (width) (height)

Do not edit. These settings store the position and configuration of the tool palettes. The 
one value that cannot be edited within Finale is (anchor), which defaults to 0. This value governs 
what the palette is positioned relative to, according to the following chart:

When anchor is Palette is positioned relative to
0 top left of application window
1 top right of application window
2 bottom left of application window
3 bottom right of application window
4 top left of screen
5 top right of screen
6 bottom left of screen
7 bottom right of screen

TS1.0=(list of space delimited tool IDs for tool set 1)
TS1.1=(continued)
TS2.0=(list of space delimited tool IDs for tool set 2)
TS2.1=(continued)
TS3.0=(list of space delimited tool IDs for tool set 3)
TS3.1=(continued)

Do not edit. These settings store the configuration for Finale's tool sets.

[Directories]

This section includes settings that are controlled in the Program Options dialog box.

MusicDir=
LibDir=
BackupDir=
AutoSaveDir=

Set in Finale. Use the Program Options dialog box to specify the directories.

[PrevFiles]

This section controls how many Finale files appear at the bottom of the File menu. The most 
recently opened files appear.

MaxPrevFiles=4
Optional. Defaults to 4 files. If you want more than four files to appear on the bottom of 

the File menu, enter the number of files you want listed. The most recently opened files appear.

PrevFile1=
PrevFile2=
PrevFile3=



PrevFile4=
Do not edit. These settings are automatically updated by Finale. They correspond to the 

most recently opened files.

About the FINMIDI.INI

The FINMIDI.INI file is created when you confirm your MIDI Setup (Options menu). All but one 
setting is controlled in Finale's MIDI Setup dialog box.

[FINMIDI]

MMESpeed=4
Optional. Defaults to 4. This value seldom needs to be edited. It controls the amount of 

milliseconds between playback interrupts. If you have a slower computer, you may want to 
increase this value to improve the playback performance. Note that the difference is very minimal. 
If you have a faster machine, you probably won't hear a difference at all.

[MMEDRVR]

MidiOutReset=0
SyncMaster=0

Set in Finale. These settings correspond to the checkboxes in the MIDI Setup dialog box.

InName1=
InBase1=
...
OutName1=
OutBase1=
OutMatch1=
...

Do not edit. Controlled in the MIDI Setup dialog box. The only values you may need to 
edit are the "OutMatch" settings. They default to 1, which means that each note on is matched up 
to a note off, even if it's the same pitch. You may need to edit this if your MIDI device cuts off all 
identical notes when the first note off is received. The Gravis Ultrasound exhibits this behavior; 
there may be other devices that behave similarly. Normally each note off is matched by a note on.

Troubleshooting

Here is a list of common problems and suggested solutions.

Screen display

Symptom: The font that appears in Finale's Message Bar is difficult to read.
Probable Cause: You are using ATM, or Windows substituted a font that is difficult to 

read.
Solution: You can select any font installed on your system in the Message Bar. Open the 



FINALE .INI file with any text editor such as Notepad. Scroll to "MsgBarFont" and 
"MsgBarFontHeight", in the [Settings] section. If nothing is entered for  "MsgBarFont=", or if the 
key does not exist,  Finale allows Windows to provide its best sans serif font. Sometimes the font 
provided by Windows is not ideal. Enter the exact font name (without leading or trailing spaces) 
that you want Finale to use for the Message Bar display. This would be the same name you see 
in the Control Panel Fonts dialog, without the parenthesized technology description (True Type, 
Plotter, VGA, etc.). (Example: Arial Bold Italic") You should change the "MsgBarFontHeight=" key 
as well to specify the font size that you want to use. Font sizes between 8-12 pixels high work 
best, but you may want to use larger values with higher resolution displays. Save the changes to 
the FINALE.INI file, and exit the text editor. 

Symptom: Finale may display data incorrectly from time to time, although this should be 
rare.

Probable Cause: Finale 3.0 offers enhancements in the way it displays elements on-
screen - you may notice that screen drawing speed is improved. However, Finale occasionally 
doesn't update the display properly if you press Ctrl-D to redraw the screen.

Solution: You can always ask Finale to renew the on-screen display "from scratch" - 
press Shift-Ctrl-D to rebuild the display. See your Quick Reference Card for more keyboard 
shortcuts.

Symptom: Sometimes when I select or move an element in the score, Finale leaves 
"ghost" images on the screen. 

Probable Cause: Your Windows Color Control Panel is set to a different color than white 
for the window background. 

Solution: These occassional drawing problems do not affect the data in your document, 
or how it is printed, in any way. We recommend setting the background color to white to avoid any 
irregularities; see your Windows documentation for specific instructions on changing color 
settings in the Windows Control Panel.

Symptom: Whenever I run my graphics card at a certain resolution my slurs fill in and look 
similar to orange slices. 

Probable Cause: There is a problem with the video driver. 
Solution: Contact the manufacturer of the card for an updated video driver.

Symptom: My stems are detached from the note heads. 
Probable Cause: There is a problem with the video driver, or the font is damaged. (Test 

the font by running the Fonts program in the Windows Control Panel.)
Solution: If the font is damaged, re-install it from the original diskette.

Symptom:  After I install Finale 3.0 the music font displays incorrectly.
Probable Cause: ATM settings are incorrect.
Solution:  Open the Adobe Type Manager Control Panel and turn off Use Pre-built or 

Resident fonts.    

Printing

Symptom: When I try print a score to a non-PostScript printer, it either does not print at all, 
or it takes a very long time to print.

Probable Cause: You're using a bitmap font, and do not have the point size that you are 
using in the score installed in your system, and Finale is trying to scale the bitmaps 
(FontScaleMode=0). This requires a substantial tempory file space, often using it up completely.

Solution: Edit the FINALE.INI file with a text editor such as NotePad. In the [settings] 
section, set FontScaleMode=1 (Windows will scale the bitmaps) or =2 (Windows will substitute 
the "closest" TrueType font.



Symptom: When I compile a PostScript listing of my score to bring to a print shop, the file 
is much larger than I expected.

Probable Cause: You're compiling a PostScript file according to Windows suggested 
setting of IndependentPSPages=1 which is compatible with print spoolers. 

Solution: If you will not be using a spooler, we recommend that you change  
IndependentPSPages from 1 to 0. Edit the FINALE.INI file with a text editor such as NotePad. In 
the [settings] section, set IndependentPSPages=0. This eliminates repetitive font downloads and 
consequently the size of the PostScript file. The disadvantage is that the resulting PostScript file 
may not work with some spoolers.

Symptom: When I print a Finale file to my non-PostScript printer it only prints staff lines. 
No musical elements such as clefs, rests or notes appear.

Probable Cause: Petrucci is a large font, and due to memory constraints, some systems 
or printer drivers have difficulty rendering it for dot matrix printer or bitmap printers such as the 
HP DeskJet.  

Solution: In the [TrueType] section in WIN.INI, add or modify the following key: 
OutlineThreshold=128. The OutlineThreshold setting lowers the point at which Windows will 
switch from bitmap rendering to vector rendering. The process is somewhat slower, but requires 
less memory. The default value is 256. You'll generally want to reduce the value: 128 works well 
for Petrucci. This value may be system dependent, so you may need to experiment with different 
values (though it should never exceed 300).

Symptom: When I print a Finale file to my HP printer with a PostScript cartridge installed, 
my printer appears to freeze, or it simply doesn't generate any output.

Probable Cause: The soft font list in the WIN.INI file is not set correctly. 
Solution: Run the Printers program in the Windows Control Panel. Make sure that a 

PostScript printer driver is selected on the correct port for your system. Exit the Printers program 
and close the Windows Control Panel. Run the Finale 3.0 Installer and re-install the fonts (you do 
not need to re-install the application or any other files). Exit and reboot Windows. Your soft font 
list should now be set correctly and you should be able to print from Finale. 

Symptom: Whenever I compile an EPS image from Finale, then print in Landscape 
orientation, it sometimes prints upside down or in the opposite corner of the page. 

Probable Cause: There is a bug in some PostScript drivers supplied with Windows. 
Solution: Edit the WIN.INI file with a text editor such as NotePad. Try adding the following 

setting to the [ModelName,Port] section of the WIN.INI file (where ModelName is the name of 
your PostScript printer model): LandScapeOrient=270.

Symptom: I have a multiple-page score that only prints the first page.
Probable Cause: Your document has probably been optimized.
Solution: Remove Optimization and choose Update Layout from the Page Layout menu.

Symptom: I get jagged edges when printing. 
Probable Cause: Printing the Petrucci PostScript version of the font on a non-PostScript 

printer.
Solution: Use the TrueType version of the font or install Adobe Type Manager to improve 

the resolution.

Symptom: The treble clef does not appear on my printed music. 
Probable Cause: You're using Adobe Type Manager and printing to a non-PostScript 

printer.
Solution: Select the checkbox for "Print ATM fonts as graphics" in the ATM Control Panel, 

or use the TrueType version of the Petrucci font.

Symptom: The "-" character does not print when using Adobe Type Manager. 
Probable Cause: You're using Adobe Type Manager and printing to a non-PostScript 



printer.
Solution: Use the TrueType version of the Petrucci font.

MIDI

Symptom: Whenever I use MIDI, my mouse freezes. 
Probable Cause: There is most likely an IRQ conflict. 
Solution: Switch IRQ setting on the MIDI card.

Symptom: I'm trying to use Speedy Entry and "Use Midi Keyboard" in the Speedy menu is 
grayed out. 

Probable Cause: No MIDI device is present. 
Solution: Install an interface or soundboard. Use the MIDI Setup dialog box (Options 

menu) to ensure that Finale knows about your device.

Symptom: The Windows system displays a message stating that the current settings don't 
match the MIDI card.

 Probable Cause: IRQ settings you have selected when you set up the driver in the 
control panel don't match the jumper settings on the MIDI card. 

Solution: Remove the interface card and correct the jumper setting.

Symptom: All my staves play back using the same sound.
Probable Cause: No instruments have been assigned to the staves.
Solution: Use the Instrument List to assign different sounds to your staves. See 

Instrument List in Finale Reference, or MIDI Channels in the Finale Encyclopedia.

Symptom: I have a controller keyboard and several sound modules. They all seem to work 
with my other MIDI applications, why don't they work with Finale? 

Probable Cause: MIDI Thru has not been selected. 
Solution: Choose MIDI Thru from the Options menu to select it.

General

Symptom: My screen saver interrupts the playback or printing of my Finale files.
Probable Cause: Many users take advantage of the standard Windows Control Panel 

screen saver, located in the Desktop program. While using this screen saver will prolong the life 
of your monitor, it may cause minor problems in playback. Specifically, when playing back music 
of sufficient length, the screen saver can engage and halt playback. Also, printing performance 
may be affected by a screen saver that engages too quickly.

Solution: Reset the delay interval on the Desktop control panel to prevent interruptions. 
For example, if playing your file takes 18 minutes, set the delay for 20 minutes or more.

Symptom: When in Speedy Entry, I sometimes see phantom notes (ones I did not play), 
appear in my score. 

Probable Cause: Some lower-cost keyboards don't send the proper note off messages. 
Solution: Turn off "Jump to Next Measure" in the Speedy menu.

Symptom: Whenever I place a shape into my score with the Staff Expression Tool, the 
identical shape I've placed elsewhere moves also. 

Probable Cause: You have not entered them as a metatool expression. 
Solution: See the Metatools section for the Staff Expression Tool in Finale Reference.

Symptom: When using the Windows Printing System with Adobe Type Manager (ATM) my 
fonts are not seen by Finale. 



Probable Cause: The cartridge provided with the WPS overrides ATM. 
Solution: If you have access to CompuServe, download the version of ATM that works 

with the WPS or call Adobe System.

Symptom: Notes occasionally disappear when I enter music. 
Probable Cause: Too many applications are open: Free System Resources (FSR's) are 

getting low. 
Solution: Close some applications in order to increase the resources available to Finale.

Symptom: I'm running Windows under OS\2 and sometimes have problems with various 
functions in Finale.

Probable Cause: Finale is not designed to run under OS\2.
Solution: Run Windows under DOS only.

Symptom: Some of my staves show up in Scroll View but not in Page View.
Probable Cause: Staves may have been optimized by mistake. 
Solution: Click the Page Layout tool and then choose Optimize Staff Systems from the 

Page Layout menu. In the dialog box that apepars, select Remove Staff System Optimization, 
then click OK. Choose Update Layout from the Page Layout menu.


